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ABSTRACT 

ABRAV is a program for measuring and displaying auditory brainstem 

response data on a PC compatible computer. ABRAV works with 

standard hardware: a PC soundcard, an evoked potential amplifier, and 

an insert earphone. ABRAV records two channels of evoked potential. 

Recording of ABR sweeps alternates between two separate buffers for 

each channel, effectively obtaining a replication of the waveform at the 

same time as the initial waveform. Two waveform quality measures, such 

as Fsp and reproducibility, are calculated and displayed during data 

collection. The operator can also manipulate the waveforms and mark 

peaks during data collection. Data files can be reviewed on a PC 

(without the need for additional hardware). Screen displays can be 

printed on any LaserJet or PostScript printer. This document is based on 

version 1.22 of the ABRAV program. 
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Introduction 

ABRAV is short for auditory brainstem response (ABR) averager. It was developed as a research tool for 
exploring better ways to obtain ABR waveforms. We wanted a program that was flexible enough to allow 
many different test parameters to be easily changed, yet friendly enough to be used in a routine clinical 
setting. 

The ABRAV program was designed to work with the following hardware1: (1) a Turtle Beach 
“Monterey” soundcard, (2) an Etymotic Research ER-10C probe microphone, (3) a Bio-logic 2-channel 
evoked potential (EP) amplifier, and (4) a PC-compatible computer running DOS or Windows 95. The 
software will also work with Turtle Beach “Pinnacle” or “Fiji” soundcards. Any earphone that is 
compatible with the soundcard could be substituted for the ER-10C, provided that the maximum output 
level can be calibrated by other means. A different EP amplifier could be used; however, the gain and 
filter settings would not be programmable. The ABRAV program is similar our otoacoustic emission 
program called EMAV.  

ABRAV has the ability to record two channels of evoked potential and display the average of sweeps on 
the screen. The accumulating of sweeps from each channel is alternated every 20 sweeps between two 
sets of buffers, so that two independent averages are maintained. All four waveforms are shown on the 
screen, giving the appearance of obtaining a waveform replication simultaneously with the initial average. 
The program has the ability to let the operator manipulate (shift and scale) the waveforms, move a cursor, 
and marks peaks while the data are being collected.  

In addition, two separate quality measures are simultaneously calculated and shown (both numerically 
and graphically) on the screen. The two quality measures are selected from a list of 5 possible measures: 
Fsp, Fmp, Scor, SNR, and reproducibility. Fsp, Fmp, and SNR are all signal-to-noise variance ratios with 
various definitions for “signal” and “noise”. Scor is the same as Fmp, except that it is multiplied by a 
cross-correlation between the recorded waveform and a stored template. Reproducibility is the cross-
correlation between two separate recorded waveforms, which are obtained concurrently. During data 
collection, both of the two selected quality measures are compared with two different threshold levels; the 
first level is intended to indicate detection of an ABR response, while the second level indicates 
acceptability of the recorded waveform.  

The program also has features to help with development of an automated ABR test. The most useful of 
these features is the ability to record and playback the raw data before it is averaged. This allows one to 
see the effect of performing the test with different parameters. The program allows changing many test 
parameters (such as type of weighting used for the average, digital high-pass and low-pass filters, and 
time windows for the quality measures) through menu options. The default values for these parameters 
are specified in a configuration file.  

Running the Program  

The program started by typing "abrav" at the DOS command prompt. The program needs to access three 
auxilliary files:  

abrav.ini - the configuration file with default values  

                                                           

1 ABRAV was originally designed to work with an Ariel DSP-16+ soundcard, an Intelligent Hearing Opti-Amp 
evoked potenial amplifier, an Otodynamics ILO-88 baby probe, and a custom-built microphone/EP switch box; 
however, support for this hardware configuration was dropped in version 1.7. 
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tbabr1.bin - DSP code for the Monterey2 soundcard  
100us.stm - stimulus file with a 100 microsecond rectangular pulse  

These auxiliary files must be in either (1) the current directory, (2) the directory where abrav.exe is kept, 
or (3) in one of the DOS “PATH” directories.  An existing ABR data file can be viewed by adding the 
name of the file to the command line. 

There are several options that may also be specified on the command line.  

-c starts the program in calibration mode 
-f filename specifies filename as a list of files for batch mode processing 
-i filename uses filename as the configuration file instead of  “abrav.ini”. 
-m starts the program in monochrome graphics mode 
-p prints files in batch mode 
-r starts the program with “run mode” set to “RECORD TO DISK” 
-v displays the program version number  
-P filename starts the program with “run mode” set to “PLAYBACK FROM DISK” and sets 

the record file to filename. 
-R filename starts the program with “run mode” set to “RECORD TO DISK” and sets the 

record file to filename. 

When the ABRAV program is running,  menus are used for both (1) selecting program functions and (2) 
entering information. A menu item is selected by either (1) pressing the key indicated by the underlined 
letter, (2) moving to the item with the cursor keys and pressing Enter, or (3) by clicking the left button of 
the mouse when the mouse cursor is over the item. Items that require information to be entered are 
"opened" when they are selected to allow entering or changing the text field. An opened item is closed 
again by pressing ether Enter (to confirm changes) or Esc (to cancel any changes). Menus stay on the 
screen until you remove them by pressing Esc.  

Performing the Tests  

Before the ABR test is started, the user may wish to enter patient/subject information by pressing “I” (for 
Info). Name, ear, patient ID, date of birth, and a comment are entered on the Info menu. (To clear the 
patient information for a new test, use the File/New function.) When the patient/subject information is 
complete, press escape to remove the Info menu.  

If necessary, changes to default test parameters are made by pressing “O” for options. Submenus are 
provided for “System”, “ABR Options”, “Response Filter and Artifact Rejection”, and “EP Amp 
Options”. 

An ABR test is initiated by typing the letter “T” (for test) and then "A" (for ABR). At this point the 
program enters the "Check Fit" phase of the test. During check fit the user should set the desired stimulus 
level and verify that the acoustic click-response waveform is acceptable. To adjust the stimulus level, 
press “1” for 10 dB, “2” for 20 dB, “3” for  30 dB, etc. Press “-” for -10 dB and “N” for -90 dB (used as 
a “no stimulus” condition”). These levels indicate the number of decibels above normal hearing threshold 
(dB nHL). Other values for the stimulus level can be selected by pressing "L" and typing the desired 
level. When the check-fit waveform appears acceptable, press Enter or "C" to proceed to the next phase of 

                                                           

2 The DSP code file for the Pinnacle/Fiji soundcard is called “tbabr2.bin”. 
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the ABR test. An alternate method for running a series of levels is to enter the levels in a file called 
RTC.LST and press “P” during check-fit. 

 

Figure 1. ABRAV edit display. Two recorded waveforms (labeled “1” and “2”) for each of two channels (labeled 
“A” and “B”) of evoked potential are displayed in the main part of the screen. The ABR waves “II”, “III”, and 
“V” are labeled at their peaks on channel A. The panel in the upper-left corner displays the growth of the Fsp 
quality measure (for both channels A and B) as a function of the number of sweeps. Text in the upper-right panel 
indicates the final values of the quality measures and the latencies of the ABR peaks. Text along the right side 
provides additional details about how the waveform and quality measures were obtained. 

 

In the data collection phase of the test, up to four ABR waveforms are shown on the screen and labeled 
A1, A2, B1, B2 (see Fig. 1). The numbers 1 and 2 represent two separate averages for each of the two 
ABR channels (A and B). A display of one of the two quality measures (or one of the two noise 
measures) will also appear at the top of the screen, as soon as 40 sweeps (2 sets of 20) have been 
accepted3. During data collection, there are several screen control and cursor movement functions 
available to the user.  

 Space redraw (update) the waveform display  
 Left-Arrow move cursor to the left a small amount  
 Right-Arrow move cursor to the right a small amount  
 Ctrl-Left-Arrow move cursor to the left a larger amount  

                                                           

3 The default number of sweeps is currently 20, but this can be changed to any number between 1 and 256. The 
acceptance of sweeps is always done in pairs. Consequently, a new set of sweeps is alsways added to both of the 
two “accumulate buffers” (1 and 2) at the same time. 
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 Ctrl-Right-Arrow move cursor to the right a larger amount  
 Up-Arrow shift waveforms up a small amount  
 Down-Arrow shift waveforms down a small amount  
 Ctrl-Up-Arrow shift waveforms up a larger amount  
 Ctrl-Down-Arrow shift waveforms down a larger amount  
 Page-Up increase the vertical size by 1.4 
 Page-Down decrease the vertical size by 1.4  
 Ctrl-Page-Up increase the vertical size by 2 
 Ctrl-Page-Down decrease the vertical size by 2  
 Del remove all vertical shifts  
 Home move cursor all the way to the left  
 Ctrl-Home move cursor to the beginning of the file  
 End move cursor all the way to the right  
 Ctrl-End move cursor to the end of the file  
 Tab shift waveform left 
 ShiftTab shift waveform right 
 + (plus) expand the time scale  
 - (minus) comress time scale  
 > increase the artifact limit by 5% of maximum value 
 < decrease the artifact limit by 5% of maximum value 
 # select a display mode with fewer points 
 0 mark the latency time origin at cursor location  
 1 mark wave I at the cursor location  
 2 mark wave II at the cursor location  
 3 mark wave III at the cursor location  
 4 mark wave IV at the cursor location  
 5 mark wave V at the cursor location a select channel A for scoring peaks  
 A select channel A for scoring peaks  
 Shift-A toggles display of channel A on/off 
 B select channel B for scoring peaks  
 Shift-B toggles display of channel B on/off 
 G (followed by 1-5)  go to peak (1=I, 2=II, 3=III, 4=IV and 5=V) 
 M toggle the display of peak labels (I, II, III, etc.) on/off 
 N toggle underline between waveform 1 and 2  on/off 
 R reset waveform scale and offsets to default values 
 S mark stimulus peak at the cursor location  
 U toggles single/all wave mode for vertical shifts  
 Shift-X don't terminate on maximum number of sweeps  
 Shift-Z reset count of accepted sweeps to zero  
 F1 displays program version information 
 F2 selects one of three waveform offset modes: all superimposed, 

superimposed by channel, or all separate. 
 F3 select one of four tracks for display: primary quality measure (PQM), 

alternate quality measure (AQM), within-block noise (Nsp), or between-
block noise (Nmn). 

 F7 selects one of three waveform display modes: A1/A2/B1/B2, 
A+/A-/B+/B-, or A+/B+.  

 F8 indicates operator acceptance of the ABR waveform  
 F9 suspends all program functions (PAUSE)  
 F10 toggles acceptance of data (PAUSE DATA COLLECTION) accept/reject 
 Esc terminates the test  
 Ctrl-C aborts the test and immediately exits to DOS  
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The vertical shift keys (Up-Arrow, Down-Arrow) normally shift all the waveforms together. To move 
waveforms individually, press "u" to underline one of the 4 waveforms. Pressing "a" or "b" alternates the 
underline between channel A and B. Pressing "n" alternates the underline between buffer 1 and 2. 
Pressing "u" again removes the underline and returns to the normal shift mode. The primary and alternate 
quality measures (PQM and AQM) are selected through the ABR options menu from a list of five 
choices: Fsp, Fmp, Scor, SNR, or reproducibility (Repr). 

An additional test mode “Tone” is allows the users to output tones to the earphone and is useful for 
verifying correct operation of the program, soundcard, and earphone. 

Reviewing Data Files  

ABRAV can open existing data files for viewing and editing. To open a file, press “F” for file and “O” for 
open. Then press “O” again to select "Open File" and see a list of all the .ABR files in the current 
directory. Use the cursor keys to select the desired file and press enter to open the file.  

Once a file is opened, the patient/subject information can be altered by pressing “I” for Info. Changes to 
the patient/subject information are not written to the data file until the File/Save function is performed. 
Waveform peaks can be marked by pressing “E” to enter "Edit mode". In edit mode, all of the screen 
control and cursor movement functions that were available during data collection (and described above) 
are available to the user, except Shift-X, Shift-Z, F8, and F10. In addition, the following functions are 
also available in Edit mode  

 F filter the averaged waveforms using zero-phase filter 
 F4 toggle display of the FFT spectra on/off  
 Shift-F4 set horizontal and vertical scales for the FFT spectra display  
 F5 displays the patient/subject info. and termination info. in the info. box  
 F6 toggle between display of the intermediate waveform or the final waveform  

The FFT spectrum display shows either “A1+A2” (blue) and “A1-A2” (yellow) or “B1+B2” (pink) & 
“B1-B2” (white) depending on whether A or B is selected. Press Esc to exit from Edit mode. If any 
changes were made to the peak location marks while in Edit mode, the user will be asked, upon exiting, 
whether these changes should be saved to the data file.  

Record and Playback  

One of most useful features of ABRAV for research purposes, is the ability to record a data collection 
session for later playback. This is very easy to do. To record a test, select the "RECORD TO DISK" mode 
using the “Run Mode” item on the “ABR Options” menu. Then perform the test in exactly the same way 
that you would otherwise. The name of the record file can also be changed from the ABR Options menu. 
The default name is record.swp. The record files are about 0.5 MB for the current default setting (1 
channel, 4000 sweeps, 20 sweeps/set, and 512 samples/sweep). The "run mode" can also be set to 
RECORD by using the -r option on the command line. In this case, the record file name will be the same 
as the .ABR data file name, except that the extension will be changed to .SWP. Another way to select 
RECORD mode and specify the filename is to use the “-R filename” option on the command line. All 
data collection controls (described above) function nornally when the run mode is set to RECORD. 

The easiest way to select a record file for playback is to select the file using the Open File function. To do 
this, the file type should be changed from ABR to SWP. Another way to select a file for playback is to set 
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the Run Mode (on the ABR Options menu) to  "PLAYBACK FROM DISK" and enter the name of the 
record file. A third way to select a file for playback is enter the file name on the command line with the “-
P filename” option. Once the record file hase been selected. Then when the ABR test is run, the sweep 
data will be read from the disk file instead of the soundcard.  

During playback, all of the normal screen control and cursor movement functions are active, and all of the 
quality measures are calculated as if the data were being collected in REAL TIME DATA mode. There is 
one additional control that is available to the user during playback:  

 ` (accent) toggles fast or slow playback speed  

In fast mode, the data is read from the disk as fast as possible. In slow mode, additional delay is added so 
that data is read from the disk at about the same rate that it is read from the soundcard in REAL TIME 
DATA mode.  

Calibration Mode  

ABRAV's calibration mode is intended as a quick check for consistency of the stimulus amplitude. The 
calibration mode is initiated by using the “-c” option on the command line. The user is instructed to 
place the ER-10C probe into a 1.5 cc cavity, set the input switch (of the ER-10C preamp) to 1 V, set the 
GAIN switch to 0 dB, and turn the power switch on. ABRAV then compares the amplitude of the 
standard stimulus (a 100 microsecond rectangular pulse) in the test cavity with a previously stored 
amplitude and reports whether these two values are close enough to be acceptable (e.g. within 3 dB).  

Printing the Screen  

The contents of the screen can be written to a printer at any by pressing Ctrl-W. There is a printer setup 
item on the File menu. Both PostScript or PCL (LaserJet or DeskJet) compatible printers are supported. 
The printer can be either local (e.g. LPT1) , on a network (e.g. \\cel\hp), or the printer output can be 
written to a file. When the screen is being printed, ABRAV changes the menu bar at the top of the screen 
to a label such as “Boys Town National Research Hospital”. 

A "batch mode" is available to view or print the opening screens of a large number of data files. For 
example, use "abrav *.abr ..." to view or "abrav -p *.abr ..." to print all of the ABR 
data files in the current directory. The files for batch processing can also be listed in a filename file that is 
specified with the -f option, like "abrav -f files.fnf".  

Menus  

There are five menus listed on the menu bar at the top of the screen: File, Info, Options, Edit, and Test. 
The first three items invoke submenus of additional menu items. Edit places an opened file into edit mode 
and Test allows the selection of either the ABR or Tone test. A menu item may be selected by pressing 
the key corresponding to the letter in the menu item which is underlined. (This is usually the first letter of 
the item.) On submenus, an item ending with "..." indicates that an additional submenu will be presented, 
an item ending with ":" indicates a text field will be opened for editing, and an item ending with "=" 
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indicates a multiple-choice selection. Short-cut keys (if any) are indicated in parentheses after the menu 
item.  

File menu 

The File menu allows the user to perform functions related to data files, screen printing, and program 
control.  

Open. Allows existing data files to be opened for review and editing of patient/subject information. A 
submenu is presented with three items.  
Open File - causes the specified file to be opened or, if the file name contains a wild card 

character, presents a list of matching files for selection.  
File Type - toggles between ABR and SWP and sets the specified file name to have the 

appropriate extension (.ABR or .SWP).  
File Name - specifies the file to be opened or pattern (with one or more wild card characters) of 

file names to be listed for selection.  

New. Erases contents of screen and patient/subject information to return the program to its initial state.  

Print Screen. Causes the contents of the screen to be printed. This command can also be invoked by 
pressing Ctrl-W.  

Printer Setup. Controls the manner in which the screen is printed. A submenu is presented with three 
items.  
Printer Port - specifies the port (e.g. LPT1) or file to which the printer output will be directed.  
Printer Type - the printer type will toggle between PostScript and PCL.  
Orientation - the printer orientation will toggle between portrait and landscape.  

File Save. Allows an open file to be saved again to update any changes made to the patient/subject 
information. If no file is currently open, the File Save function is disabled.  

Write Log. Creates a log file from an open data file. The name of the log file will be the same as the data 
file, except that the extension will be changed from ".abr" to ".log". If no file is currently open, 
the Write Log function is disabled. The log file records a summary of the ABR test results. 

About ABRAV. Displays information about the current version and authors of the ABRAV program. 
This function can also be invoked by pressing F1.  

Exit. Terminates the ABRAV program and returns to the DOS command line. This function can also be 
invoked by pressing Ctrl-C.  

Info menu  

The Info menu allows the user to enter the patient/subject information that will be stored in the data file. 
The patient/subject information in existing data files can still be modified by opening the file, editing the 
information, and then saving the file. There are six items on the Info menu: Last Name, First Name, Ear 
(left or right), ID (patient identification number), Date of Birth, and Comment.  

Options menu  

The Options menu allows the user to change many of the parameters that affect the program operation 
and test measurement. Most of these parameters can also be assigned initial values in the configuration 
file. There are four items on the Options menu: System Options, ABR Options, Artifact Rejection, and EP 
Amp Options. The correspondnig sub-menus are described below. 
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System Options … sets parameters that affect both ABR and Tone tests.  
Display Units (mV or mPa) - determines whether units displayed during micorphone recording 

are expressed in terms of voltage (mV) or sound pressure (mPa) 
I/O Sensitivity … sets parameters describing the DAC, ADC, and ER-10C characteristics.  

AD (cnt/V) - ADC sensitivity in counts per volt.  
DA1 (cnt/V) - DAC channel A sensitivity in counts per volt.  
DA2 (cnt/V) - DAC channel B sensitivity in counts per volt.  
MP (V/Pa) - microphone sensitivity in volts per pascal.  
LS1 (V/Pa) - loud speaker (receiver) channel A sensitivity specified in volts per pascal.  
LS2 (V/Pa) - loud speaker (receiver) channel A sensitivity specified in volts per pascal.  

ABR Options … sets parameters that affect the ABR test.  
Stimulus Options … sets parameters that affect the ABR stimulus.  

Size of Token - specifies the number of samples in the ABR stimulus.  
Stimulus Polarity - Selects either ORIGINAL or REVERSED stimulus polarity.  
Rate of Clock (Hz) - Specifies the ADC and DAC sample rates.  
Stimulus File - the name of the stimulus file used for both the checkfit and measurement 

phases of the ABR test.  
Averaging Options … sets parameters that affect the ABR averaging process.  

Sweeps per set - The number of sweeps in each set for the measurement phase of the 
ABR test.  

Weighted Average - Specifies one of four different types of weighting for the average.  
NO all sweeps are uniformly weighted  
VAR sweeps are weighted by the reciprocal of the variance of the difference 

between two sets of sweeps  
RMS sweeps are weighted by the reciprocal of the square root of the variance of 

the difference between two sets of sweeps  
SPVAR sweeps are weighted by the reciprocal of the variance of the single point 

within the two sets of sweeps  
Minimum Set Pairs - Quality measures will not be compared to threshold values until 

this number of sweeps has been competed. ABR test will not terminate 
automatically before this number of sweeps has been recorded. 

Maximum Set Pairs - ABR test will terminate when this number of sweeps has been 
recorded. 

Quality Measure Options … sets parameters that affect the ABR quality measures.  
Primary Quality Measure - Selects which of the quality measures (Fsp, Fmp, Scor, 

repro, or SNR) will be used to any automatic stopping criteria.  
Alternate Quality Measure - Selects which of the quality measures (Fsp, Fmp, Scor, 

repro, or SNR) will be tracked in addition to PQM.  
First Track (PQM/AQM/Nsp/Nav) - Selects which of two of quality measures or two 

noise measures will have its track displayed first during data collection or Edit 
mode.  

Start Time4 (ms) - start of analysis window. (Same as Time1 in the configuration file.)  
End Time (ms) - end of analysis windows. (Same as Time2 in the configuration file.  
Correlate with - species whether the Scor statistic will be computed using a correlation 

between the two, concurrent subaverages (replication) or with the previously 
stored template. 

                                                           

4 Start Time and End Time set the boundaries of the time window over which the quality measures are calculated.  
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Display Options … sets parameters that affect the ABR waveform display.  
Points Displayed - Selects either 128, 256, 512 or ALL (2048) points for display. Fewer 

points are displayed by skipping intermediate points.  
Waveform Polarity - Selects normal or reversed polarity when displaying waveform.  

Run/Stop Options … - sets parameters related to running or stopping the test  
Run Mode - specifies one of three modes related to record of sweep file:  

REAL TIME DATA - the normal data collection mode.  
RECORD TO DISK - sweeps are written to disk during data collection  
PLAY BACK FROM DISK - reads sweeps from disk instead of collecting new 

data  
Record File - The name of the sweep file used for either record or play back modes.  
PQM Stop Mode - Selects PQM stopping criteria from one of five choices: No, VR1 on 

A, VR2 on A, VR1 on B, and VR2 on B. VR1 and VR2 are variance ratio values 
that are specified in the configuration file and compared with the primary quality 
measure to make an early stopping decision. 

OK Stop Mode - determines whether the ABR test terminates when the operator judges 
the waveform to be "OK". 

Filter Options … - sets parameters related to the zero-phase filter implemented in software 
during datacollection.  
Hi-Pass Filter5 Frequency (Hz) – zero-phase, high-pass filter implemented in sofware. 

(Same as F1 in the configuration file.) 
Lo-Pass Filter Frequency (Hz)  - zero-phase, low-pass filter implemented in software. 

(Same as F2 in the configuration file.) 
Filter Type – determines whether the high-pass and low-pass filters are turned on (zero-

phase) or off (none). 

Artifact Rejection … - sets parameters related to EP artifact rejection . 
Rejection Threshold (mV) - Initial rejection threshold for voltage at the ADC. (Same as "limit" 

in the configuration file.)  
Reject Mode - Selects between two methods of artifact rejection6:  

RAW uses the minimum and maximum of values obtained directly from the ADC over 
every sample in the set of sweeps  

MEAN uses the minimum and maximum values of the average of the set of sweeps over 
samples within the selected time window  

EP Amp Options … - sets parameters related to the EP amplifier.  
Hi-Pass Filter (Hz) - Sets the cut-off frequency of the high-pass filter on the EP amplifier. 
Lo-Pass Filter (Hz) - Sets the cut-off frequency of the low-pass filter on the EP amplifier. 
Amplifier Gain - Sets the gain of the EP amplifier, not including the preamplifier gain. 
Preamp Gain - Sets the gain of the EP preamplifier. 
Coupling - Sets the internal coupling of  the EP amplifier to be AC or DC. 

                                                           

5 The digital filters are applied to the set of sweeps after uploading from the soundcard. Since the Fsp measure 
depends on the sum of the sqaures of the single point which is calculated by DSP on the soundcard, the Fsp value 
will not be valid when the digital filters are used. The default value for the cutoff frequencies is zero; this value 
disables the digital filters.  

6 Arifacts will be reduced in the average of 1 set of sweeps, so the artifact limit for the MEAN mode should be set 
to a smaller value than for th RAW mode. For example, if the number of sweeps per set is 20, the MEAN mode 
limit should be less than the raw mode limit by a factor of at least the scale root of 20. Even then, the MEAN mode 
will be less effective at rejecting sets of sweeps with impulsive noise spikes.  
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Notch Filter - Sets the 60 Hz notch filter to be In or Out. 

The remaining items on the menu bar at the top of the screen (Edit and Test) have already been described 
above.  

Configuration File  

The configuration file is called "abrav.ini" by default and can be located in the current directory, the 
directory containing the program (abrav.exe) or any directory listed in the DOS PATH variable. The file 
is divided into three sections SYSTEM, PRINTER, and ABR. Each section begins with a line containing 
the name of the section enclosed in brackets. The parameters that can be given values are described below 
for each section. The default value for each parameter is indicated. Lines that begin with a semicolon in 
the configuration file are ignored and can be used for comments or temporarily disabling a parameter 
setting. The letters in the parameter name can be either upper or lower case. Many of the parameter may 
also be changed through the Options menu while running the ABRAV program. Changing a parameter 
value within ABRAV will not change the initial value specified in the configuration file.  

When the parameter values are listed below, their default values are indicated after the equals sign, 
followed on the next line by a brief description. 

SYSTEM parameters  

The SYSTEM section begins with the word in brackets like this: [SYSTEM]. Parameters in this section 
apply to all tests.  

AD_sensitivity = 9400 
specifies the sensitivity of the ADC in counts per volt 

DA1_sensitivity = 17000 
specifies the sensitivity of the DAC for channel A in counts per volt 

DA2_sensitivity = 17000 
specifies the sensitivity of the DAC for channel A in counts per volt 

DSP = M 
specifies the type of soundcard: M = Monterey/Tahiti; P = Pinnacle/Fiji 

DSP_code = tbabr1.bin 
specifies the name of the DSP code file. 

EP_channel = AB 
specifies which channel or channels of the soundcard (A, B, or AB) receives the evoked potential 
signal.  

LS1_sensitivity = 2  
specifies the loud speaker (receiver) sensitivity for channel A (including any series resistance) in 
units of volts per pascal.  

LS2_sensitivity = 2  
specifies the loud speaker (receiver) sensitivity for channel B (including any series resistance) in 
units of volts per pascal.  
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MP_channel = A  
specifies which channel of the soundcard (A or B) receives the microphone signal.  

MP_sensitivity = 5  
specifies the microphone sensitivity (including the gain of the microphone preamplifier) in units 
of volts per pascal.  

Refresh = 0  
sets the display screen refresh time to a specified number of seconds. If set to zero, then the 
automatic refresh feature is turned off.  

PRINTER parameters  

The PRINTER section begins with the word in brackets like this: [PRINTER]. Parameters in this section 
relate to printing the contents of the screen. 

Label = Boys Town National Research Hospital  
the heading that appears across the top of the screen when it is printed.  

Orient = Landscape  
The printing of the screen is specified to be one of two possible orientations: Landscape or 
Portrait.  

Port = screen.ps  
The printer port may be specified by name (such as LPT1 or LPT2) or a network name (such as 
\\cel\hp). If the name is not recognized as port name, a file with that name will be opened for 
output. It is also possible to specify a DOS command to be executed for printing, by preceding 
the command with an exclamation mark. For example, you could execute the "lpr" command for 
printing by having "Port=!lpr". The output for the printer will be written to a temporary file and 
the name of that file will be appended to the command line when it is executed.  

Type = PostScript  
You can choose one of two printer types: PostScript or PCL. The PostScript output is suitable 
for including in other documents as an Encapsulated PostScript file. The PCL output can be used 
with either HP LaserJet or DeskJet printers.  

ABR parameters  

The ABR section begins with the word in brackets like this: [ABR]. Parameters in this section relate to 
the ABR test.  

AQM = Fsp  
Specifies the alternate quality measure to be either Fsp, Fmp, Scor, SNR, or Repr. The AQM will 
be tracked along with the PQM.  

cal_atten = 11.5  
Specifies the (internal) attenuation applied during the calibration check (using “-c” option).  

chk_atten = 31.5  
Specifies the (internal) attenuation applied during the check-fit phase of the ABR test.  

chk_swps = 20  
The number of sweeps to be averaged before updating the display during the check fit phase of 
the ABR test.  

Page 13 



EPA_ACC = AC  
Species coupling of the EP amplifier to be AC or DC.  

EPA_AGN = 100  
Species the gain of the EP amplifier not including the preamp. Values range from 1 to 300. 

EPA_HPF = 100  
Species cutoff frequency of the high-pass filter on the EP amplifier. Values range from DC to 300 
Hz. 

EPA_LPF = 3000  
Species cutoff frequency of the low-pass filter on the EP amplifier. Values range from 30 to 
10000 Hz. 

EPA_NTF = Out  
Species notch filter (at 60 Hz) of the EP amplifier to be In of Out.  

EPA_PGN = 1000  
Species gain of the preamplifier for the EP amplifier to be either 50 or 1000.   

F1 = 0  
The frequency of the digital high pass filter applied to each set of sweeps. The default value of 
zero disables the high pass filter.  

F2 = 0  
The frequency of the digital low pass filter applied to each set of sweeps. The default value of 
zero disables the low pass filter.  

FFTdB = 40  
The vertical full-scale range (in decibels) of the ABR spectrum display.  

FFTkHz = 2  
The horizontal full-scale range (in kilohertz) of the ABR spectrum display.  

Filter = None  
Allows the high-pass and low-pass software filters to be turned on (Zero-Phase) or off (None).  

list = rtc.lst  
Specifies the name of a file containing a list of stimulus levels.  

limit = 1500  
This parameter specifies the initial threshold (in millivolts) for artifact rejection during the 
measurement phase of the ABR test. The threshold value may be modified during the data 
collection by using the '>' or '<' keys.  

MakeTemplate = 1  
Specifies whether sum and difference waveforms are written to the data file, 0 = no, 1 = yes. 
There are also side-effects. If set to 0, then an intermediate set of waveforms (A1, A2, B1, B2) 
may be written to the data file on occurrence of certain events, in addition to the final set of 
waveforms. If set to 1, then the buffer that stores quality-measure and noise tracks is expanded, 
allowing the storage of tracks that are 3 times as long. 
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Max_Level = 70  
This parameter specifies the simulus level that will be produced when the program applies no 
attenuation in dB nHL.  

Min_Sets = 20  
This parameter specifies the number of sweep sets that will be accumulated (in each of the four 
waveform buffers) before the quality criteria will be checked. This guarantees than least this 
number of sweep sets will be averaged before the any of the quality measures reach their criteria.  

NHL_Level = 35  
Normal hearing threshold level in dB pSPL. This parameter defines dB nHL. 

Nmp = 5  
Number of sample points used for the between-block noise computation.  

OK_Stop = 0  
Controls how the ABR tests stops automatically based on operator indicating OK: 0 = OK does 
not stop test, 1 = stop when operator inicates OK. 

PQM = Fmp  
Specifies the primary quality measure to be either Fsp, Fmp, Scor, SNR, or Repr. The PQM will 
be tracked and used for any automatic stopping criteria.  

PQM_Stop = 0  
Controls how the ABR tests stops automatically based on the primary quality measure (PQM): 0 
= no stopping rule, 1 = stop when the PQM exceeds VR1 (or Repr1), 2 = stop when the PQM 
exceeds VR2 (or Repr2). 

rate = 22050  
Specifies the DAC and ADC sample rate in units of samples per second.  

Record_File = record.swp  
Specifies the name of the file used for recording and playing back sets of sweeps.  

Reject_Mode = RAW  
Specifies the mode of artifact reject to be either RAW or MEAN.  

repr1 = 60  
repr2 = 90  

The first and second level criteria for reproducibility when it is used as the primary quality 
measure.  

Run_mode = 0  
Specifies one of three run modes 0 = "Real time data", 1 = "Record to disk", and 2 = "Play back 
from disk".  

sets = 100  
Specifies the maximum number of sweep-set pairs to be recorded. The ABR test will terminate 
when this number of sets has been accepted. 

size = 512  
Specifies the number of samples in the stimulus file. This number also determines the stimulus 
repetition rate and the number of samples in the recorded EP waveform. 
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stimulus = 100us.stm  
The file name of the stimulus to be used for the ABR test.  

Sweeps = 20  
For efficiency, the total number of sweeps averaged for each test is divided into sets with a few 
sweeps in each set. This parameters specifies the number of sweeps in each set for the 
measurement phase of the ABR test.  

Target = 90  
Specifies the desired level (dB pSPL) for the standard stimulus in the standard (1.5 cc) cavity in 
dB pSPL. Used to the calibration mode: “abrav –c”.  

Time1 = 4  
Time2 = 14  

Specifies the start and end of the time window within which the quality measures are computed.  

Tolerance = 3  
Specifies the alllowed deviation of the peak level from the Target level of the standard stimulus in 
the standard (1.5 cc) cavity. Used to the calibration mode: “abrav –c”.  

Tone_Freq = 1000  
Specifies the initial tone frequency (in Hz) used for the tone test.  

Tone_Level = 60  
Specifies the initial tone level (in dB SPL) used for the tone test.  

VR1 = 2  
VR2 = 3  

The first and second level criteria for the primary quality measure (unless the PQM is 
reproducibility).  

Wt_Av = VAR  
Specifies the weighting for the averaging to be either NO, RMS, VAR, or SPVAR.  

Xrange = 16  
Specifies the number of milliseconds included in the response window during the ABR test. This 
number can be adjusted during the test by using the "+" and "-" keys.  

Yrange = 2e-6  
Specifies the number of microvolts that correspond to the full vertical range of the response 
window during the ABR test. This number can be adjusted during the test by using the Ctrl-Page-
Up and Ctrl-Page-Down keys.  

Stimulus Files  

The ABRAV program uses external stimulus files for the check fit and calibration phases of the test. The 
same stimulus file is used for the calibration and measurement phases of the test. (The tone stimuli used 
for the Tone test is generated internally). The external stimulus files have a binary format which is 
essentially the same as an ILS sampled- data file. These files have a 512 byte "header" followed by the 
stimulus waveform. The header contains information about the sample rate and length of the stimulus. 
The waveform is written as 16-bit integers, two bytes per sample.  
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Data Files  

The ABR test generates a binary data file with a ".abr" extension which contains 10 waveform buffers. 
The first buffer contains the recorded stimulus waveform. The next four buffers contain the two separate 
measurements of the ABR waveform for each of the two channels (A1, A2, B1 and B2). The sixth buffer 
buffer contains the 4 tracks: AQM, PQM, Nsp, and Nav. The contents of the last four buffers depends of 
the setting of the Make_Template parameter in the configuration file. If set to 0, then the last four 
buffers may contain an intermediate set of the four ABR waveforms (A1, A2, B1, B2) upon occurrence of 
a special event prior to termination of the test. There are two special events that can cause the 
intermediate waveforms to be stored: (1) PQM exceeds the citerion value set by VR2; or (2) Operator 
indicates that the waveforms are acceptable by pressing F8 during the test. If Make_Template is set to 1 
(currently the default value), then two of the last four buffers are used to store additional track data and 
the last two buffers store a sum and difference of the ABR waveforms. The additional track buffers allow 
the stored track lenth to be three times as long. Normally the track length is limited to one-eighth the size 
of the buffer. The sum and difference waveforms are computed only for channel A unless channel A is 
not specified as an EP channel, in which case the sum and difference waveforms are stored only for 
channel B. 

Patient/subject information and stimulus conditions are also saved in this file. The file format is a 
BTNRH tokenfile. This file format is similar to an ILS sampled-data file, with additional information 
appended. The waveforms in the ABR data file may be viewed with the BTNRH WavEd program and 
spectrographs can be generated with the BTNRH SPECTO program.  

New .ABR file names are generated automatically. The .LOG file is given the same name as the 
corresponding .ABR file. The file names are based on the current date and a sequence number. The file 
name begins with the last two digits of the current year, followed by a single letter corresponding to the 
month, (A=January, B=February, etc.), then the day within the month and, finally, the sequence number. 
There are 777 possible sequence numbers: 00, 01, ... 99, AA, AB, ... ZZ, and ##. The current sequence 
number is stored in a file called "abrav.cnt". A new file name is first compared with files in the current 
directory and the sequence number incremented until no existing file is found with the same name.  
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